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About This Guide

This guide describes Active WorkFlow Management (TM), and provides information on 
using your system.

Available Documentation
Active WorkFLow Management includes the following documentation:

n Online Help – To open the HTML online help system, click the Help button on 
the Active WorkFlow Management tool bar.

n Active WorkFlow Management(TM) User Guide – This guide is provided as a 
printable .pdf file (Active WorkFlow Management User Guide.pdf) and is 
installed in the \doc directory where you installed Active WorkFlow 
Management(TM).

n Readme  – This document (readme.html) contains last-minute changes to the 
software and documentation and is installed in the root directory where you 
installed Active WorkFlow Management(TM).



1

Getting Started

In This Chapter ...

Active WorkFlow Management Concepts10

Logging In to Active WorkFlow Management(TM) on 
page11

Navigating Active WorkFlow Management(TM) on 
page12
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Active WorkFlow Management(TM) 

Concepts
Active WorkFlow Management(TM) uses a web interface that is accessible from 
your web browser and is designed to help you Active WorkFlow Management 
access project and tasActive WorkFlow Managementk iActive WorkFlow 
ManagementActive WorkFlow Management information easily. Active 
WorkFlow Management(TM) provides the tools and information a user needs to 
perform work on a project. In addition, depending on system authorization, 
valuable project and task Active WorkFlow Management information can be 
shared with others who may not be assigned to the project.Active WorkFlow 
Management (TM) consists of three basic work folders:

n Workspace  –  The Workspace provides a system-wide view that is filtered 
for each particular user. The Workspace provides each user with instant 
access to their work assignments. Work assignments are delivered to the user 
in the form of a task folder. If you are assigned to a task, then you also have 
access to the project folder the task folder was created in. The user can also 
perform a system-wide search for documents, task folders, and project 
folders. The Workspace is the first page you see when you log in to Active 
WorkFlow Management(TM).

n Project – The project folder contains all information that is essential to the 
completion of the project. The project folder is comprised of all tasks created 
in the project, a list of all resources assigned to the project, a list of important 
documents approved in the task folders of the project, and the status of all 
issues created in the project.

n Task – The task folder contains all information that is essential to the 
completion of the task. The task is comprised of criteria (work items), a list of 
all resources assigned to the task, all documents that need to be created, 
revised, or approved in this task,  all discussion threads that took place in the 
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task folder, and all issues opened in this task folder. If a user is assigned to a 
task folder, they are able to work with the task folder. For example, a user can 
add and revise documents in the task folder.

Logging In to Active WorkFlow Management(TM)

Active WorkFlow Management(TM) is a web-based application that you run with a 
web browser. Whenever a user logs in to Active WorkFlow Management(TM), the 
Workspace folder is displayed. From the Workspace, users can access project 
information.

4To log in to Active WorkFlow Management (TM)

1. Open your web browser.

2. In your browser’s address field, type the following:

http://your_machine_name/iProject/jsp/login.jsp.

In the above example, your_machine_name is the computer you installed 
Active WorkFlow Management(TM) on.

3. Press ENTER. The Welcome screen appears.

4. In the User ID  field, type your user identification. 

5. In the Password  field, type your password.

Note: Your system administrator will provide you with your own personal 
User ID and password.
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6. Click Login. Active WorkFlow Management(TM) is launched and the 
Workspace page appears.

4To log out of Active WorkFlow Management(TM)

In the toolbar, click Logout. The Welcome screen appears.

Changing Your Password

Once you have logged in to Active WorkFlow Management(TM), you may want to 
change your password.

4To change your password

1. In the toolbar, click Password . The Change Password tab appears.

2.  In the Old Password field, type your current password.

3. In the New Password field, type your new password.

4. In the Confirm New Password  field, retype your new password.

5. Click Submit. Your password has been changed.

Navigating Active WorkFlow Management(TM)

The Active WorkFlow Management(TM) user interface uses visual cues to 
represent the level of the system you may currently be in. For example, if you are 
in a project folder, the Project folder is open and the name of the project folder is 
displayed. The following example depicts the Admin user in the Design 
Production project folder.

The following example depicts the Admin user in the Design and Development 
task folder, which is one of the task folders that makes up the Design Production 
project folder.

The Admin user is in the 
Design Production project 
folder. Click the user’s 
Workspace name to 
return to the Workspace.
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The Admin user is in the 
Design and Development 
task folder. Click the 
name of the project link to 
return to the project 
folder.
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Toolbar

Use the toolbar to perform the following tasks:

Sorting Lists

Project folders, task folders, and documents are presented in sortable lists. To sort 
these items in Active WorkFlow Management (TM) lists, click the column headers. 
The lists can be sorted in ascending or descending order.

Italicized Field Labels

Italicized field labels in Active WorkFlow Management (TM) represent required 
information fields. For example, when you create a new project in Active 
WorkFlow Management(TM), the Project Name, Project Description, and 
Customer/Sponsor fields require information. A project cannot be created 
without this information being submitted.

Click To View

Workspace Your Workspace page

Admin Add resources to Active WorkFlow 
Management (TM) (available to Admin users only)

Change Password Change Password tab

Help Active WorkFlow Management (TM) online help 
system

Logout Logs you out and returns you to the Welcome screen

Italicized field labels are 
required information fields.
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Your Workspace Folder

In This Chapter ...

Workspace Folder Overview on page 16

Workspace Tabs on page 16

Searching in Active WorkFlow Management(TM) on 
page17
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Workspace Folder Overview
Users interact with Active WorkFlow Management(TM) via the Workspace. From 
the Workspace page, you can manage your task work and access project 
information. From the Workspace, users can navigate through Active WorkFlow 
Management(TM) to access project and task information.

If you have navigated to a task folder or project folder, and want to return to your 
Workspace, click Workspace in your toolbar or select the Workspace User 
navigation link.

Workspace Tabs
The Workspace is divided into four tabs:

n Tasks – When you first log in to Active WorkFlow Management (TM), the 
Workspace displays the Tasks tab by default. The Tasks tab lists all tasks that 
are currently active, and assigned to you. An active task is a task that has 
already begun, but is not yet completed.

n Gantt – The Gantt tab provides you with a visual representation of all tasks 
that are assigned to you in Active WorkFlow Management(TM). This includes 
all completed, active, and future tasks. The default view of tasks is four 
weeks forward and one-week back. 

Workspace User link
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n Projects  – The Project tab lists all projects that are assigned to you in Active 
WorkFlow Management (TM). Once a project is closed, it will not appear in this 
list. If you are the project manager of a project, that project will be listed here 
as well.

n Search – The Search tab enables you to search Active WorkFlow 
Management(TM) for documents, task folders, and project folders. You will 
only be able to retrieve and view items you are authorized to see.

Accessing Your Work Assignments
All of your project and task assignments can be instantly accessed via your 
Workspace. 

n Your Active Task Assignments – In the Tasks tab of your Workspace, you 
can view and access active tasks that you are assigned to. An active task is a 
task that has already begun but is not yet completed. To access a task, click 
the task links to open the task folder. Once you have completed your work on 
a task, it is removed from the active list.

n All Task Assignments  – In the Gantt tab of your workspace, you can view 
and access all of your future, active and completed tasks. These tasks 
represent all of your task assignments in Active WorkFlow Management(TM), 
across all projects. The default view of tasks in the Gantt is four weeks 
forward and one-week back. Task folders can be opened from the Gantt.

n All Project Assignments – In the Project tab of you Workspace, you can 
view a list of all your project assignments in Active WorkFlow 
Management(TM). In order to receive a task assignment you must first be 
assigned to the project. A project must have a status of open to appear on this 
list. Click the project link to open the project folder. You may be assigned to a 
project without being assigned to any of its tasks.

Searching in Active WorkFlow Management (TM)

Use the Search tab to search the Active WorkFlow Management system. You can 
search for Active WorkFlow Management(TM) documents, task folders, and 
project folders. For example, you may want to find a task that has been 
completed, and is no longer accessible from your Workspace. You can narrow the 
number of matches your search finds by providing search criteria.
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4To search the system

1. From your Workspace, click the Search tab. The search criteria fields 
appear.

2. Type your search criteria:

n Name – the name of the item you are searching for

n Description – a description of the item you are searching for

3. Select the type of item you are searching for:

n Projects

n Tasks

n Documents

4. If you want to find an item by date, select the Date option. When selected, 
you can specify the following search options:

n Created – Click to specify the date the item was created.

n Modified – Click to specify the date the item was modified.

n in the last – Select and type the number of days, weeks, or months that the 
item was either created or modified within.

n between – Select and type the date range that the item was either created 
or modified between. The date format used is MM/DD/YY. You can also 
use the date calendar to specify the date range. To use the date calendar, 
click the calendar icons. 

5. Click Search . Your search results are displayed.

Select the Date  option 
to specify date criteria 
for your search.
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Project Search Results

If you performed a project search, the following information is displayed to help 
you identify the project you are looking for. 

n Number  – The number that the system assigns the project when it is created. 
This number is unique in Active WorkFlow Management (TM). Click this link 
to access the project folder. This number is used to identify a project when 
creating a sub-project link. For more information, see “Working With a Task 
Folder” on page 33.

n Project – The name of the project provided by the project manager. Click this 
link to access the project folder.

n Start – The date the project starts, provided by the project manager.

n Finish  – The date the project is scheduled to end. This date does not effect 
the actual end date of the project. A project does not officially end until the 
project manger chooses to close it.

n Sponsor – This is the name of the customer or sponsor of the project and is 
provided by the project manager.

n Project Manager – This is the user that created the project and is responsible 
for its successful completion. The project manager is the only user that can 
modify the project plan.

n Status  – A project either has a status of open or closed. Once a project is 
closed, it does not appear in the users Workspace.

Task Search Results

If you performed a task search, the following information is displayed to help you 
identify the task you are looking for.

n Task Number – The number assigned to the task by the system. The number 
is unique to the project it is created in. Click this link to access the task folder.

n Task – The name provided by the project manager for the task. The name can 
be used to search for the task in Active WorkFlow Management (TM). Click this 
link to access the task folder.

n Project – The project number this task is assigned to. Click this link to access 
the project folder.

Click the project number 
or name to open the 
project folder.
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n Scheduled Start – This date represents the date the task begins. The project 
manager provides this date via the Gantt chart.

n Scheduled Finish  – This date represents the date the task is scheduled to 
finish. The project manager provides this date via the Gantt chart.

n Finish Date  – This date represents the actual date the task was completed. It 
is entered by the system. If this column is blank, the task is still active.

Document Search Results

If you performed a document search, the following information is displayed. You 
can view the document or save the document to a location on your computer. 
Documents are associated with tasks.

n Project # – The project number of the project this document is associated to. 
Click this link to open the project folder.

n Task #  – The task number of the task this document is associated to. Click 
this link to open the task folder.

n Name – The name of the document that was entered by the user (creator) 
who originally added it to Active WorkFlow Management(TM). Click this link 
to view the document or save it to your computer.

n Description  – The description of the document entered by the creator. The 
description can be used to search for the document.

n Version # – Each document is automatically given a version number by the 
system. When a document is revised inside a task folder, the version number 
is incremented as minor versions, for example Task A, version 2.0 is revised 
twice in this task. The version number of the first revision is 2.1, and the 
second revision is 2.3. When a document is added from another task folder, 
the version number is incremented as a major version. For example, Task A, 
version 2.0 is added to Task B. The version number in Task B is incremented 
to 3.0.

n Last Modified – This is the date the document was last modified on.

n Modified By – This is the name of the resource that last modified the 
document. Documents can only be modified via the task folder.

Click the task number or 
task name to open the task 
folder. Click the project 
number to open the project 
folder.
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n Created  – This represents the date the document was originally added to 
Active WorkFlow Management(TM).

n Creator – The resource that originally added the document to the Active 
WorkFlow Management(TM).

Click the project number to 
open the project folder. 
Click the task number to 
open the task folder. 

Click the name of the 
document to save the 
document on your 
computer.



3

Project Folder

In This Chapter ...

Project Folder Overview on page24

Accessing Project Tasks on page25

Viewing Project Issues on page 25

Viewing Project Resources on page 26

Viewing Project Documents on page26



Project Folder

24 Avtive WorkFlow Management

Project Folder Overview
The project folder contains all information that is essential to the completion of 
the project. The project folder is comprised of all tasks created in the project, a 
list of all resources assigned to the project, a list of important documents 
approved in the task folders of the project, and the status of all issues created in 
the project.

Project Folder Tabs
The project folder is divided into five tabs:

n Tasks – When you open a project folder, the Tasks tab is displayed by 
default. The Tasks tab lists all tasks in this project that are currently active 
and assigned to you. An active task is one that has already begun, but is not 
yet completed.

n Gantt – The Gantt tab provides you with a visual representation of all tasks 
that are assigned to all resources, in the entire project. This includes all 
completed, active, and future tasks. The default view of tasks is four weeks 
forward and one-week back. Tasks that you are authorized to see can be 
opened from here.

n Issues – The Issue tab lists all issues related to this project. During the life of 
a project, several challenges may arise that throw the project off schedule. 
For example, a part that was integral to the completion of a task is scheduled 
to arrive two weeks late. To keep the task on schedule, other options may 
need to be reviewed. A resource assigned to the task folder responsible for 
the receipt of this part, can post an issue in the Collaboration tab of the task. 
All issues posted in the tasks of a project display on the Issues tab. 

n Resources  – The Resources tab of the project folder contains a list of all 
resources that are assigned to this project. Additional information such as 
telephone numbers and email addresses are listed for each resource. This 
ensures that each project resource has the required information to contact 
other resources. The project manager is able to manage resources from here.
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n Documents  – The Documents tab of the project folder contains a cumulative 
list of all approved documents that are available on the Documents tab of all 
its tasks.

Accessing Project Tasks
n Your Active Task Assignments in this Project – In the Tasks tab of the 

project folder, you can view and access your active task assignments in this 
project. Once you have completed your work on a task, it is removed from 
the active list. 

n All Tasks in this Project  – In the Gantt tab of the project folder, you can 
view all tasks assigned in this project. The project Gantt is a visual 
representation of the entire project. You can access the task folders for all 
tasks you have been assigned from the Gantt. Provided you have the 
appropriate authorization, you will be able to access task folders for tasks that 
were not assigned to you. 

Viewing Project Issues
From the Issues tab of the project folder you can view all issues related to this 
project. This list is for viewing only, so issues cannot be opened or closed from 
here. Issues must be closed in the task folder they were originally opened in. You 
can click the task number to quickly navigate to the task folder that contains the 
issue:

n Issue #  – Active WorkFlow Management(TM) automatically assigns each issue 
a number when it is created. The number assigned is unique to the project.

n Task #  – This is the task number of the task the issue was opened in. To 
navigate to the task folder, click this link.

n Opened  – This is the date the issue was opened. 

n Author  – This is the name of the resource that opened the issue.

n Description  – This is a description of the issue and the potential resolution. 
The author enters this when the issue is opened.

n Status  – An issue is either opened or closed. When an issue is first posted, its 
status is open. To close an issue the resource must select the close function in 
the Collaboration tab of the task folder.

Note: On the Issues tab, a green square icon helps identify issues that are 
open.
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Viewing Project Resources
From the Resources tab of the project folder you can view a list of all resources 
that are assigned to this project. The following additional information is provided 
for each resource:

n Name – The name of the resource.

n Organization – The organization this resource is associated with.

n Location – The location of the organization this resource is associated with.

n Phone  – The phone number this resource can be reached at.

n Fax – The fax number this resource can be reached at.

n Email – The email address for this resource.

Viewing Project Documents

From the Documents tab of the project folder you can view a cumulative list of 
all documents that are contained in the Documents tab of all its tasks folders. The 
following information for each document is listed:

n Name – The name of the document. Click this link to view the document. 
You can also click the Item Menu icon in the left column and select View 
from the menu. 

n Description  – The description of the document to help resources identify it.

n Template  – The template type if the document originated from a template. 
Templates can be grouped by type.

n Task #  – The task number associated with this document. Click this link to 
open the task folder.

n Last Modified – The date this document was last modified.

n Modified By – The name of the resource that last modified this document.

n Version # – The version number associated with this document.
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Task Folder Overview
The task folder contains all information that is essential to the completion of the 
task. The task is comprised of criteria (work items), a list of all resources 
assigned to the task, all documents that need to be created, revised, or approved 
in this task,  all discussion threads that took place in the task folder, and all issues 
opened in this task folder. If a user is assigned to a task folder, they are able to 
work with the task folder. For example, a user can add a document template to the 
task and revise it. Other users may only have access to open the folder or no 
access at all.

Task Folder Tabs
The task folder is divided into four tabs:

n Operations  – When a task folder is opened, the Operations tab is displayed 
by default. This tab contains task detail such as a description, scheduled start 
and end dates, and task criteria. If the task has been assigned to resources, it 
also displays the status of their work. Work status can either be Done or To be 
done.

n Resources  – On the Resources tab you will find a list of all resources 
assigned to this task. The project manager has the option to manage task 
resources from here.

n Collaboration – The Collaboration tab is where resources communicate 
using discussion threads. All resources assigned to the task as well as other 
users with the appropriate authorization can post these discussions. The 
Collaboration tab is also where resources assigned to the task can open and 
close issues that effect the completion of the task. Documents can be added to 
these discussions but are only included as viewable attachments. They can be 
viewed but not edited and are not included on the project document list.
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n Documents  – The Documents tab is where resources view, add, revise and 
approve documents crucial to this task. Documents can only be added to 
Active WorkFlow Management(TM) through the Documents tab.

Viewing a Task Folder
A Task Folder can be viewed from many different areas of the system. If you are 
assigned to the task, the quickest way to open the task folder is clicking the task 
link from your Workspace or the project folder. If you are not assigned to the 
task, but have authorization to see the task folder, you could execute a search to 
find it.

Viewing Task Details

From the Operations tab you can view a task’s details and criteria. Criteria 
identifies work and who is responsible for the work. From the Operations tab, 
task team members can indicate the need for additional time to complete the 
criteria or link their task’s start date to the end date of another project’s task.

4To view a task’s details

On the Tasks  tab, click the task number or task name of the task folder whose 
details you want to view. The task folder appears, displaying the task details and 
task criteria on the Operations tab.

Viewing Task Documents

Task documents can be viewed from the Documents tab of the Task Folder. The 
document is downloaded to your local computer for viewing.

4To view task documents

1. On the Tasks tab, click the task number or task name of the task that contains 
the document you want to view.

2. Click the Documents  tab. The task’s documents are listed.

3. Click the name of the document you want to view. The File Download dialog 
appears.

4. Click one of the following:

n Open – The document is opened.

n Save – Navigate to the location you want to save the document to and then 
click Save. To view the document, navigate to the location you saved the 
document to, and open the document.
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Viewing Task Resources

From the Resources tab of the task folder you can view a list of all resources that 
are assigned to this task. The following additional information is provided for 
each resource.

n Name – The name of the resource.

n Organization – The organization this resource is associated with.

n Location – The location of the organization this resource is associated with.

n Phone  – The phone number this resource can be reached at.

n Fax – The fax number this resource can be reached at.

n Email – The email address for this resource. 

Viewing Task Discussions or Issues

Use the Collaboration tab to view discussion items and issues that are related to 
this task. 

4To view task discussions or issues

1. On the Tasks  tab, click the task number or task name of the task whose 
discussion items you want to view. The task folder opens.

2. Click the Collaboration tab. The task’s discussion and issue items appear.

3. Click the Subject column of discussion item you wish to view. All replies 
posted to this discussion display. 

4. To return to the main page of the Collaboration tab, click All Topics.

Viewing Documents Attached to a Message

You can access documents attached to a message. You can choose to view the 
documents or save them on your computer. You cannot revise a document that is 
attached to a message.

4To view a document attached to a message

1. On the Task tab, click the task number or task name of the task that contains 
the document you want to access.

2. Click the Collaboration tab. The task’s collaboration messages appear.

Note: A green square icon helps identify issues and discussions that are 
open.
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3. In the list, click the subject of the post that contains the document you want to 
access. The contents of the message are displayed.

4. Click the name of the document. The File Download dialog appears.

5. Click one of the following:

n Open – The document is opened.

n Save – Navigate to the location you want to save the document to and then 
click Save. To view the document, navigate to the location you saved the 
document to, and open the document.

Working With a Task Folder

If you are the project manager of the project or a resource assigned to the task, 
you will be able to work with the task folder by adding new criteria, documents, 
and collaborations. Each resource assigned to a task folder must also indicate 
when their work on the task is complete. This is done in the Operations tab of the 
task folder. Depending on a user’s authorization, they may be able to add 
collaborations to a task folder even if they are not assigned as a resource on the 
task.

Adding New Criteria

The criteria of a task is found on the Operations tab, and can identify work items, 
task requirements, or any other information that is important to the task. The 
project manager and all resources that are assigned to the task can enter criteria.

In addition to adding a description, you can identify a person responsible for the 
criteria by typing their initials into the Responsible field. You can also enter a 
start and end date for this work. If this criteria is dependent on the completion of 
a task contained in another project, you can link this criteria to the finish date of 
that task by entering the other project’s number and task number. The system will 
then automatically use the finish date of the sub-project task and add it to the 
criteria finish date. It is the finish dates that are linked.

4To add a new criteria

1. On the Tasks  tab, click the task number or task name of the task folder you 
want to add new criteria to. The task folder appears displaying the Operations 
tab, which contains the task detail and criteria.

2. In the Add New Criteria  section, provide the following information:

n Criteria Description – Type a brief description of the instruction, 
requirement or work item.
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n Person(s) Responsible – Type the initials of the resources who are 
responsible for this work. This field can be left blank.

n Projected Start/Finish Date – Type the project start and finish date for 
this item. The date format used is MM/DD/YY. You can also use the date 
calendar to specify the dates. To use the data calendar, click the calendar 
icons.

n Sub-Project/Task ID – If this task criteria is dependent on a task from a 
different project, you can connect them together. Doing so, connects the 
finish date of your task criteria to the finish date of the task from the other 
project (sub-project). The task criteria finish date automatically changes to 
the sub-project’s task finish date. To use this feature, you need to type the 
sub-project identification number and the tasks identification number.

3. Click Submit. The new task criteria is listed in the task folder’s Current Task 
Criteria list.

Revising Task Criteria

The project manager and any resource assigned to a task are able to perform 
revisions on task criteria. 

4To revise task criteria

1. On the Tasks  tab, click the task number or task name of the task whose 
criteria information you want to revise. The task folder appears displaying the 
Operations tab, which contains task detail and criteria.

2. In the Current Task Criteria list, click the criteria whose information you 
want to revise.

3. Revise the criteria information. For example, you can modify the Projected 
start/end dates and link them to a sub-project.

4. Click Save This Criteria. The task criteria is updated to reflect your 
revisions.

Note: If the projected finish date you type extends beyond the project 
manager’s scheduled dates, the finish date will appear at “+ x days”. 
This acts as an indicator to the project manager that more time is 
needed to complete this item. The project manager can then choose 
to adjust the scheduled dates of the task.

Note: If you enter an incorrect project number or task number the system 
will advise the project or task cannot be found. No link is created.
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Adding Task Documents

You can add two types of documents to a task: internal or external documents. An 
internal document is one that already exists inside Active WorkFlow 
Management(TM). For example, a resource may want to use a document that is part 
of another task, or a document template. An external document is any document 
on your network that you want to add to this task.

4To add an internal document to a task

1. On the Tasks  tab, click the task number or task name of the task you want to 
add the document to.

2. Click the Documents  tab. The task’s documents are listed.

3. Click Add  Existing. 

4. In the search fields, specify your search criteria and then click Search. The 
results of the search are displayed.

5. Click the Item Menu icon next to the document you want to add to the task, 
and click Add. The document list is updated to reflect your additions.

4To add an external document to a task

1. On the Tasks  tab, click the task number or task name of the task you want to 
add a document to.

2. Click the Documents  tab. The task’s documents are listed.

3. Click Add  New. The Add New Document page appears.

4. In the Name field, type an identifying name for the document you are adding 
to the task folder.

5. Click Browse  and navigate to the location of the document you want to add, 
select the file, and then click Open. The File field displays the directory 
location of the file.

6. Click Submit. The document list is updated to reflect your additions.

Note: You have the option to search for the document in Current Project 
or Template Type.
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Revising Task Documents

If you want to modify a document, you must use the Checkout  option. When a 
document is checked out, a lock is placed on the document, which prevents other 
individuals from modifying that document. They are still able to view the 
document but cannot check it out of Active WorkFlow Management(TM).

Once you have revised the document, you can then check the document back into 
Active WorkFlow Management(TM). The system will automatically provide a new 
version number for the revised document and record the date, time, and name of 
the resource that modified it. In order to check a document back in to the system, 
you must be the resource that checked it out.

4To check out a document

1. On the Tasks  tab, click the task number or task name of the task you want to 
add a document to.

2. Click the Documents  tab. The task’s documents are listed.

3. Click the Item Menu icon next to the document you want to check out, and 
click Checkout . A check mark appears next to the document in the list and 
the File Download dialog appears.

4. Click one of the following:

n Open  – The document is opened.

n Save – Navigate to the location you want to save the document to and then 
click Save. To view the document, navigate to the location you saved the 
document to, and open the document.

5. Once the document is checked out you can modify the document, save it, and 
check the document back in.

4To check in a document that is checked out

1. On the Tasks tab, click the task number or task name of the task that contains 
the document you want to check in.

2. Click the Documents  tab. The task’s documents are listed. Documents that 
are checked out have a blue check mark next to their name on the Documents 
tab.

3. Click the Item Menu icon next to the document you want to check in, and 
then click Checkin.

4. If you are reviewing the document or just want to select this one as the 
approved version, select Approve as Master.
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5. In the Comment  field, type any comments you want to be displayed with the 
document when it is checked in.

6. Click Browse. Navigate to the location of the document, select the document 
and click Open.

7. Click Checkin. The document is checked in. Active WorkFlow 
Management(TM) automatically assigns a new version number to the modified 
document.

4To undo a checkout

1. On the Tasks tab, click the task number or task name of the task that contains 
the document whose check out you want to cancel.

2. Click the Documents  tab. The task’s documents are listed. Documents that 
are checked out have a blue check mark next to their name on the Documents 
tab.

3. Click the Item Menu icon next to the document you want to undo the 
checkout for, and then click Undo Checkout .

4. The check mark and lock on the document is removed. No version change is 
made to the document.

Adding a Task Discussion or Issue Item

If you have an item you would like to discuss with other resources in the task, 
you can post a discussion item here. If you have identified an issue, it can be 
posted here. Issues posted at the task level automatically display on the project 
folder’s Issues tab.

4To post a new message

1. On the Task  tab, click the task number or task name of the task you want to 
post a new message to.

2. Click the Collaboration tab. The task’s current message items appear.

3. Click Post New Message.

4. In the Type drop-down list, click one of the following:

n Discussion – Click if you want to open a discussion thread.

n Issue – Click if you want to open an issue in this task folder.

5. In the Subject  field, type the subject of your message.
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6. If you want to associate a document with this message, click Browse, 
navigate to the location of the document and double-click the document. The 
directory location of the document is displayed in the File field.

7. In the Message field, type the content of your message.

8. Click Submit. Your message is posted on the Collaboration tab.

Once a message has been posted, a reply can be added to it.

Replying to a Message

When you reply to a message, you can add a document to your response. 

4To reply to a message

1. On the Task tab, click the task number or task name of the task you want to 
post a reply message to.

2. Click the Collaboration tab. The task’s current message items appear.

3. In the list, click the subject of your message you want to add a reply to. The 
contents of the message display

4. Click Reply.

5. In the Subject field, type your comments on the subject.

6. If you want to associate a document with this message, click Browse, 
navigate to the location of the document and double-click the document. The 
directory location of the document is displayed in the File field.

7. In the Message field, type the content of your comments.

8. Click Submit. Your reply displays in the Collaboration tab.

9. To return to the original message in the discussion, click Go To Parent. The 
original message in the discussion is displayed.

10. To return to the main page of the Collaboration tab, click All Topics.

Note: On the Collaboration tab, a green square icon helps identify issues and 
discussions that are open.
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Adding Documents to a Task Discussion or Issue Item

You can add a document to a task discussion or issue item. If you want to add a 
document to a task discussion or issue item you are creating, see “Adding a Task 
Discussion or Issue Item” on page 37. You can also add a document to an already 
existing task discussion or issue item. For more information, see “Replying to a 
Message” on page 38.

Completing Your Task Work

Each resource that is assigned to a task folder will have any number of work 
items they must complete. For example, a resource may be required to add a 
document to the task and revise it. The same resource may also be required to 
review another document and approve it. Once the resource has completed all 
work they are required to perform for this task, the resource must advise Active 
WorkFlow Management(TM) that they have completed their work. This is done in 
the Operations tab of the task folder.

4To mark your task work complete

1. On the Tasks tab, click the task number or task name of the task whose work 
you have completed. The task folder appears displaying the Operations tab.

2. In the Resources Status section, each resource name appears with their 
current status, Done or To Be Done . Beside your name is an action button that 
allows you to indicate your work is complete. Click Done.

3. You are returned to your Workspace. In the task folder, the button beside your 
name changes to ReOpen . 

Reopening Your Task Work

Once you have indicated your work is complete, you are permitted to undo that 
action. The task must be active in order for the ReOpen  option to be available.

4To reopen your task work

1. On the Tasks tab, click the task number or task name of the task whose work 
you have completed. The task folder appears displaying the Operations tab.

2. In the Resources Status section, each resource name appears with their 
current status, Done or To Be Done . Beside your name is an action button that 
allows you to reopen your work after you have indicated it was complete. 
Click ReOpen . The button changes to Done.
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Creating a New Project
An individual who creates a new project is automatically designated as that 
project’s project manager.

4To create a new project

1. From your Workspace, click the Projects  tab. The Projects tab lists active 
projects that you are assigned to.

2. Click Create Project. 

3. In the Project Name field, type the name of the new project.

4. In the Project Description field, type a brief description of the new project.

5. In the Project Catalog  drop-down list, click the catalog you want to assign 
the new project to.

A catalog acts as a container for projects. For example, your organization 
may have separate catalogs for internal and external sponsored projects.

6. In the Project Template drop-down list, click the project template you want 
to use to create the new project.

Project plan templates help maintain structure and consistency in Active 
WorkFlow Management(TM) project plans. You add and maintain project plan 
templates via the Admin link on the toolbar. For more information, see 
“Managing Project Plan Templates” on page 68.

7. In the Customer/Sponsor field, type the customer or sponsor of the new 
project.

8. In the Start Date and Finish Date fields, type the start and finish dates of 
your new project. The date format used is MM/DD/YY. You can also use the 
date calendar to specify the dates. To use the date calendar, click the calendar 
icons.

9. Click Submit. The Projects tab is updated and displays your new project.

Assigning Resources to a Project

Resources can be assigned to a project. Users must be enrolled as a resource 
before they can be assigned to a project. For more information, see “Enrolling 
Users as Resources ” on page 64. Once the resource has been added to the 
project’s assignment list, they become available for task assignment.
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4To assign a resource to a project

1. From your Workspace , click the Projects  tab. The Projects tab lists all your 
projects assignments. If you are a project manager, all the projects you 
manage will also display.

2. In the projects list, click the name or number of the project that you want to 
assign a resource to. The project folder opens.

3. Click the Resources  tab. The Resources tab lists any resources that are 
currently assigned to the project.

4. Click Manage Resources.

5. In the Available list, click the resource you want to assign to the project, and 
then click Assign. 

6. Click Finished. The Resources tab is updated to reflect your changes.

4To replace a resource on a project

1. From your Workspace , click the Projects  tab. The Projects tab lists all your 
projects assignments. If you are a project manager, all the projects you 
manage will also display.

2. In the projects list, click the name or number of the project that you want to 
replace a resource on. The project folder opens.

3. Click the Resources  tab. The Resources tab lists any resources that are 
currently assigned to the project.

4. Click Manage Resources.

5. In the Available list, click the resource you want to assign and in the 
Assigned list, click the resource you want to replace.

6. Click Replace . The resource that was replaced moves back to the Available  
list and the new resource moves to the Assigned  list.

7. Click Back. The Resources tab is updated to reflect your changes.

Note: You can select multiple users in the Available list by clicking the 
resources and holding down the CTRL key.
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4To remove a resource from a project

1. From your Workspace, click the Projects  tab. The Projects tab lists all your 
projects assignments. If you are a project manager, all the projects you 
manage will also display.

2. In the projects list, click the name or number of the project you that want to 
remove a resource from. The project folder opens.

3. Click the Resources  tab. The Resources tab lists any resources that are 
currently assigned to the project.

4. Click Manage Resources.

5. In the Assigned list, click the resource you want to remove from the project, 
and then click Unassign.

6. Click Back. The Resources tab is updated to reflect your changes.

Creating New Tasks
A project is made up of individual tasks. When a new task is created, the new task 
is assigned to a project. A new task is created using the Gantt tool in a project 
folder. 

Adding New Tasks to a Project

Use the Gantt tool to add tasks to a project. Tasks that you add to a project will be 
listed on the Tasks tab in the project folder.

4To add a new task to a project

1. From your Workspace, click the Projects  tab. The Projects tab lists active 
projects that you are assigned to.

2. On the Projects tab, click the project number or project name of the project 
you want to add a task to. The project folder appears.

3. Click the Gantt tab. The project’s Gantt tool appears, displaying the project’s 
tasks.

4. In the Edit menu, click Insert Activity . A new task is added to the Gantt 
chart.

Note: You can select multiple users in the Assigned list by clicking the 
resources and holding down the CTRL key.
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5. In the Name column, double-click the new task and type the name of the new 
task in the task name field.

6. In the Plan menu, click Save. The Select Plan dialog appears. By default, the 
Create a new revision plan  option is selected.

7. To create a project revision plan, click Save. The Update Project dialog 
appears, confirming your project plan is revised. Or to make these changes to 
the Live Gantt, click Publish . 

8. Click OK. To view the project’s new task, click the Tasks tab. The Tasks tab 
lists all tasks associated with the project.

Adding a Task Constraint

Tasks can be assigned constraints. A constraint between two tasks ties the end 
date of the task to the start date of another task. For example, a project manager 
assigns a constraint between two tasks, task A and task B. The constraint between 
tasks A and B ensures that task B does not begin until task A is completed.

4To add a task constraint

1. From your Workspace , click the Projects  tab. The Project tab lists all 
projects that you are assigned to and ones you manage.

2. On the Projects tab, click the project number or project name of the project 
whose task you want to assign a constraint to. The project folder appears.

3. Click the Gantt tab. The project’s Gantt tool appears, displaying the project’s 
tasks in the Gantt chart.

4. In the Edit menu, click Create Constraint . Your mouse cursor appears as 
cross-hairs over the map pane of the Gantt tool.

5. On the map pane, connect together the two tasks you want to create 
constraints against.

6. In the Plan menu, click Publish  to send your changes to the live Gantt or 
click Save to save your changes as a project plan revision.

Parent and Child Tasks

Tasks can be classified as parent and child tasks. A parent task is a task that is 
made up of one or more tasks. For example, task Design Scheduling  is a parent 
task, made up of two child tasks, Design Research and Design Implementation. 
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The children task’s start and end date dictate the start date and end date of the 
parent task. For example, if the end date of the child task Design Implementation 
is extended by three days beyond the end date of the parent task Design 
Scheduling , the new child task end date becomes the parent task’s end date. A 
parent task is considered complete once all its child tasks are completed. 

4To make a task a child or parent task

1. From your Workspace, click the Projects  tab. The Project tab lists all 
projects that you are assigned to and ones you manage.

2. On the Projects tab, click the project number or project name of the project 
whose task you want to make a child or parent task. The project folder 
appears.

3. Click the Gantt tab. The project’s Gantt tool appears, displaying the project’s 
tasks in the Gantt chart.

4. In the map pane, click the task you want to make a child or parent task.

5. In the Edit menu, click the following:

n Indent Task – The selected task becomes a child task of the preceding 
task. The preceding task becomes the parent task.

n Outdent Task – The selected child task becomes a regular task. You can 
only outdent child tasks.
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6. In the Plan menu, click Publish  to send your changes to the live Gantt or 
click Save to save your changes as a project plan revision.

The following is an example of parent and child tasks and task constraints.

Assigning Resources to a Task

Once a resource is assigned to a project, the resource becomes available for task 
assignment. Only resources assigned to the project can be given task 
assignments. A task is not enabled until at least one resource has been assigned to 
it. Once a task is enabled, the color of the task is changed to dark blue.

4To assign a resource to a task

1. From your Workspace , click the Projects  tab. The Projects tab lists all your 
projects assignments. If you are a project manager, all the projects you 
manage will also display.

2. In the projects list, click the name or number of the project whose tasks you 
want to assign a resource to. The project folder opens.

3. In the tasks list, click the task you want to assign a resource to. The task’s 
Operations tab displays.

4. Click the Resources  tab. The Resources tab lists all resources that are 
currently assigned to the task.

5. Click Manage Resources.

The Scoping and 
Specifications  task is a parent 
task to the Resourcing and 
Implementation and 
Conclusion and Testing  child 
tasks.

The Conclusion and 
Testing task and the 
Implementation task have 
a constraint between them.
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6. In the Available list, click the resource you want to assign to the task, and 
then click Assign. 

7. Click Back. The Resources tab is updated to reflect your changes.

4To replace a resource on a task

1. From your Workspace, click the Projects  tab. The Projects tab lists all your 
project assignments. If you are a project manager, all the projects you manage 
will also display.

2. In the projects list, click the name or number of the project whose tasks you 
want to replace a resource in. The project folder opens.

3. In the tasks list, click the task you want to replace a resource in. The task’s 
Operations tab displays.

4. Click the Resources  tab. The Resources tab lists all resources that are 
currently assigned to the task.

5. Click Manage Resources. 

6. In the Available list, click the resource you want to assign and in the 
Assigned list, click the resource you want to replace.

7. Click Replace. The resource that was replaced moves back to the Available  
list and the new resource moves to the Assigned list.

8. Click Back. The Resources tab is updated to reflect your changes.

4To remove resources from a task

1. From your Workspace, click the Projects  tab. The Projects tab lists all your 
projects assignments. If you are a project manager, all the projects you 
manage will also display.

2. In the projects list, click the name or number of the project whose tasks you 
want to remove a resource from. The project folder opens.

3. In the tasks list, click the task you want to remove a resource from. The task’s 
Operations tab displays.

Note: You can select multiple users in the Available list by clicking the 
resources and holding down the CTRL key.

Note: When a resource is replaced or removed from a task, the resource 
remains assigned to the project and available for other task assignments 
in the project.



User Guide 49

Project Management

4. Click the Resources  tab. The Resources tab lists all resources that are 
currently assigned to the task.

5. Click Manage Resources.

6. In the Assigned list, click the resource you want to remove from the task, and 
then click Unassign. The resource is moved to the Available list.

7. Click Back. The Resources tab is updated to reflect your changes.

Managing a Task’s Detail

The project manager of a project is the only user who can perform modifications 
to tasks in addition to those already described in “Working With a Task Folder” 
on page 33. These modifications include editing the name and scheduled dates of 
the task. These changes must be performed from the Gantt tool and must be 
published before they display on the Live Gantt. For more information, see 
“Gantt Tool” on page 51.

4To revise a task’s name, start or end date

1. From your Workspace , click the Projects  tab. All projects that you are 
assigned to and ones you manage will list.

2. On the Projects tab, click the project number or project name of the project 
whose task you want to modify. The project folder opens.

3. Click the Gantt  tab. The project’s Gantt tool appears displaying the project’s 
tasks.

4. From the Gantt Chart, double-click in the task’s Name, Start or End 
columns, and type your changes to the task details.

Note: You can select multiple users in the Assigned list by clicking the 
resources and holding down the CTRL key.

Note: When a resource is replaced or removed from a task, the resource 
remains assigned to the project and available for other task assignments 
in the project.
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5. In the Plan menu, click Publish to send the changes to the Live Gantt or click 
Save to save these changes as a project plan revision.

4To revise a task’s description

1. On the Task tab, click the task number or task name of the task whose 
description you want to edit. The task folder opens displaying the task’s 
details and criteria.

2. In the Description  field, edit the text as required. 

3. Click Update Description  to apply your changes.

Closing or Removing a Message

Once a message has been fully examined and its issues no longer need further 
discussion, the message can be closed or removed by the project manager.

4To close or remove a message

1. On the Tasks  tab, click the task number or task name of the task whose 
message you want to close.

2. Click the Collaboration tab. The task’s message items appear.

3. In the list, click the Menu Item icon beside the message you want to close or 
remove. Click Close to close the message for discussion or Remove to delete 
the discussion from the task folder. The list is updated to reflect you changes.

Note: You can also modify the task’s dates via the map pane of the Gantt tool. 
You either can drag the task’s bar to modify the start and end date, or 
pull the task’s start or end date individually into position on the map 
pane.

Note: On the Collaboration tab, a green square icon helps identify issues 
and discussions that are open.
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In This Chapter ...

Gantt Tool Overview on page 52

Gantt Concepts on page52

Gantt Tool User Interface on page52

Working With the Gantt Tool on page 53
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Gantt Tool Overview
The Gantt tool provides Active WorkFlow Management(TM) users a visual 
representation of a project that shows the scheduling and inter-dependencies of 
project tasks.

Gantt Concepts

When working with the Gantt tool, users are always working with the Live Gantt. 
If you are the project manager, then you are able to work with both the Live Gantt 
and project plan revisions. When a project plan revision is published, its changes 
are implemented in the Live Gantt.

Project Plan Revisions and Live Gantt

n Live Gantt  – This is the official project plan that resources interact with. 
This is the published project plan. All modifications to the task folders are 
updated as they are changed.

n Project Plan Revision  – This is a revision of the Live Gantt. Project 
managers are able to save different versions in order to try out various 
scenarios. These project plan revisions are numbered sequentially. Only the 
project manager of a project can save and access its project plan revisions.

Gantt Tool User Interface

The Gantt tool user interface is comprised of two panes: the chart pane and the 
map pane. The chart pane is a table that lists all the project’s tasks. The map pane 
provides a visual layout of the tasks. The tasks are colour coded to help you 
recognize the status of each task. When a task is created in the Gantt, a bar 
appears in the map pane. The colour of the task changes when the following 
happens:

n Enabled  – These are tasks that have at least one resource assigned to them. 
These tasks are dark blue.

n Completed – These tasks are completed, so they are not editable by anyone. 
Completed tasks are green.
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Working With the Gantt Tool

Project management functions available when using the Gannt tool are:

n Add a new task

n Modify a task’s start and end dates

n Create a task constraint

n Create a parent or child task

n Create and save project plan revisions

n Publish a project plan revision to add it to the Live Gantt

For information on adding a new task, modifying a task’s start and end dates, 
creating task constraints, or creating a parent or child task, see “Project 
Management” on page 41.

Modifying a Live Gantt

If the project manger decides to change any item contained in the Live Gantt’s 
chart pane, they must publish the plan. For example, if the project manager adds a 
task to the project, (line added to the chart pane) the task displays but is not sent 
to the Live Gantt until it is published.

4To publish a project plan

1. From your Workspace , click the Projects  tab. The Projects tab lists all 
projects you are assigned to and manage.

2. On the Projects tab, click the project number or project name of the project 
you want to modify. The project folder opens.

Task chart pane.

Task map pane.



Gantt Tool

54 Avtive WorkFlow Management

3. Click the Gantt tab. The project’s Live Gantt appears, displaying the 
project’s tasks.

4. Modify the project plan as required. 

5. From the Plan menu, click Publish.

6. Active WorkFlow Management (TM) will check to ensure you have not changed 
any events that have already occurred. If everything is synchronizes with the 
Live Gantt, the revision plan is published. If an error is detected, an error 
message will advise you what the issue is. You can correct the issue and the 
attempt to publish it again. Once the revised project plan is published, all 
existing revision plans for this project are deleted. 

Creating a Project Plan Revision

If the project manager does not want to apply changes to the Live Gantt, they can 
save the change as a project plan revision. When this is done, the system assigns 
a version number to the revised project plan.

To use one of the project plan revisions, the project manager must publish it. If 
the Live Gantt and the project plan revision become too unsynchronized, the 
project plan revision may not be publishable. A message will advise the project 
manger of what the issues are so they can modify the project plan revision before 
attempting to publish it again. 

4To create a project plan revision

1. From your Workspace, click the Projects  tab. The Projects tab lists all 
projects you are assigned to and manage.

2. On the Projects tab, click the project number or project name of the project 
you want to modify. The project folder opens.

3. Click the Gantt tab. The project’s Live Gantt appears, displaying the 
project’s tasks.

4. Modify the project plan as required. 

5. From the Plan menu, click Save.

6. In the Select Plan dialog, select the Create a new revision option. 

7. Click Save. Active WorkFlow Management (TM) assigns the project plan a 
version number and loads the plan in the Gantt tool. The revision number is 
displayed in the top-right corner of the map pane.
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4To save or publish a project plan revision

1. From your Workspace , click the Projects  tab. The Projects tab lists all 
projects you are assigned to and manage.

2. On the Projects tab, click the project number or project name of the project 
you want to save or publish. The project folder opens.

3. Click the Gantt tab. The project’s Gantt tool appears, displaying the project’s 
tasks.

4. In the Plan menu, click Open. The Select Plan dialog appears.

5. In the list, select the project plan revision you want to open, and then click 
Open. The project plan revision loads in the Gantt tool. The revision number 
appears in the top-right corner of the map pane.

6. Modify the plan as required and then click one of the following:

n Save – Displays the Select Plan dialog where you can choose to Replace 
existing plan (save to current plan) or Create a new revision plan.

n Publish – Publishes the project plan. The changes are added to the Live 
Gantt.
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In This Chapter ...

The Admin Module and Security Roles on page 58

Enrolling Users as Resources on page64

Managing Document Templates on page65

Managing Project Plan Templates on page 68
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The Admin Module and Security Roles
In the Admin module, System Administrators add new users to the system and 
assign these users to a security role. A user is an individual who will need to log 
in to Active WorkFlow Management(TM) and a role is a security classification that 
defines what type of access and privileges the user will be assigned. Before a user 
can be added to a role, the user must be added to the system. To add a new user to 
the system, you will need access to the Admin module. The Admin module is 
installed in the root directory where you installed Active WorkFlow 
Management(TM).  

4To add a new user to the system

1. In the Active WorkFlow Management(TM) root directory, double-click the 
dmsadmin.bat  file.

2. To log in to the Admin module, use the following default login information:

n User ID – Admin

n Password – admin

3. In the tree view pane, double-click the Security folder.

Note: To access the Admin module, the Active WorkFlow Management(TM) 
Console must be running. The Console is installed in the root directory 
where you installed Active WorkFlow Management(TM). To run the 
Console, double-click the dmsconsole.bat  file in the Active WorkFlow 
Management(TM). root directory.

Note: All user IDs and passwords are case-sensitive.
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4. In the tree view pane, right-click Users, and then click Add.

5. In the dialog field, type a name for the new user.

6. Click OK. The new user is added to the tree view pane.

7. In the Description  field, type a brief description of the user.

8. To assign the user a password, click Change. The Change Password dialog 
appears.

9. In the Password  field, type a password for the user. The user can later change 
the assigned password in the Active WorkFlow Management(TM). For more 
information, see “Changing Your Password” on page 12 or the online help 
system.

10. In the Verify Password field , retype the password, and then click OK.

11. In the Email Address field, type the user’s email address.

12. In the Admin module menu, click File > Commit Change.

Assigning Users to Roles

Four roles have been created to accommodate Active WorkFlow Management (TM) 
application security. Your System Administrator is responsible for assigning each 
user to one of the four roles via the Admin module when users are added to 

Double-click the 
Security  folder.

The tree view pane 
in the Admin 
module.
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Active WorkFlow Management(TM). To assign a user to one of the four roles, you 
will need access to the Admin module. The Admin module is installed in the root 
directory where you installed Active WorkFlow Management(TM).

Note: To access the Admin module, the Active WorkFlow Management(TM) 
Console must be running. The Console is installed in the root directory 
where you installed Active WorkFlow Management(TM). To run the 
Console, double-click the dmsconsole.bat  file in the Active WorkFlow 
Management root directory.
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The following table identifies and defines each role:

Role Access

Executive n The user can open all projects and task folders 
(retrieved through a search) in the system.

n The user can add collaborations to all task folders in 
the system. (The task cannot have a status of 
complete.)

n To open a project folder, the user must be on the project 
assignment list.

n To open a task folder, the user must be on the project 
assignment list. The user can open all task folders in a 
project.

n To edit a task folder, the user must be on the task 
assignment list.

n The user has admin privileges in the system. For 
example, the user can enrollment resources.

n The user can create projects in Active WorkFlow 
Management (TM). 

n The user can replace self in the task assignment list 
even if they are not the project manager of the project 
that contains the task.

n The user can be a project manager of a project. The 
projects are listed in the user’s Workspace. If the user is 
the project manager of a project, they can perform the 
following functions in their project:
n create and delete tasks

n edit task properties in the Gantt chart

n assign resources to the project assignment and task 
assignment lists (users can also remove resources)

n replace self anywhere in the project

n open, edit, and complete all task folders in the 
project

n complete project
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Manager n To open a project folder, the user must be on the project 
assignment list.

n To open a task folder, the user must be on the project 
assignment list. The user can open all task folders in a 
project.

n To edit a task folder, the user must be on the task 
assignment list.

n The user has admin privileges in the system. For 
example, the user can enrollment resources.

n The user can create projects in Active WorkFlow 
Management (TM). 

n The user can replace self in the task assignment list 
even if they are not the project manager of the project 
that contains the task.

n The user can be a project manager of a project. The 
projects are listed in the user’s Workspace. If the user is 
the project manager of a project, they can perform the 
following functions in their project:

n create and delete tasks
n edit task properties in the Gantt chart

n assign resources to the project assignment and task 
assignment lists (users can also remove resources)

n replace self anywhere in the project

n open, edit, and complete all task folders in the 
project

n complete project

Collaborator n To open a project folder, the user must be on the project 
assignment list.

n To open a task folder, the user must be on the project 
assignment list. The user can open all task folders in a 
project.

n To edit a task folder, the user must be on the task 
assignment list.

Guest User n To open a project folder, the user must be on the project 
assignment list.

n To open or edit a task folder, the user must be on the 
task assignment list.

Role Access
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4To assign users to roles

1. In the Active WorkFlow Management(TM) root directory, double-click the 
dmsadmin.bat  file.

2. To log in to the Admin module, use the following default login information:

n User ID – Admin

n Password – admin

3. In the tree view pane, double-click the Security folder.

4. In the tree view pane, double-click the Roles folder.

5. In the tree view pane, click the role you want to assign the user to.

Note: All user IDs and passwords are case-sensitive.

Click the role you 
want to assign the 
user to.



Administration

64 Avtive WorkFlow Management

6. Click the Default  catalog, and then click Add.

7. In the Principals  list, click the user you want to assign to role, and then click 
OK.

8. In the Admin module menu, click File > Commit Change.

The user is now available to be enrolled as a resource in Active WorkFlow 
Management(TM). For more information, see “Enrolling Users as Resources ” on 
page 64.

Enrolling Users as Resources
Active WorkFlow Management(TM) users are added to the system via the Admin 
module. Once an individual is added as a user, they can log in to Active 
WorkFlow Management(TM). In order for users to be assigned to projects and 
tasks, they must first be enrolled as a resource in Active WorkFlow 
Management(TM). You enroll a resource via the Admin link on the toolbar. 
Enrolling is a process by which the user is added as a resource to the system.

Active WorkFlow Management(TM) contains four separate security roles. Roles 
control the type of access a user will have in Active WorkFlow Management (TM). 
In the Admin module, users are then assigned to roles according to their Active 
WorkFlow Management(TM) responsibilities. For more information on roles and 
the Admin module, see “The Admin Module and Security Roles” on page 58.

Click the Default  
catalog, and then click 
Add.
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4To enroll a user as a resource

1. In the toolbar, click Admin.

2. Click Add Resource. The Add Resource page appears.

3. In the Catalog drop-down list, click the catalog you want this resource to be 
part of. 

A catalog acts as a container for projects. For example, your organization 
may have separate catalogs for internal and external sponsored projects.

4. In the User Id  list, click the resource whose user identification you want to 
assign.

5. In the identification fields, type the resource’s user identification information.

6. Click Submit. The Enroll Resources tab is updated to reflect your changes.

4To edit a resource’s information

1. In the toolbar, click Admin.

2. In the resource list, click the name of the resource whose information you 
want to edit. The Edit Resource page appears.

3. In the resource information fields, edit the resource’s information.

4. Click Submit. The resource list is updated to reflect your changes.

4To remove a resource

1. In the toolbar, click Admin. 

2. Click the Item Menu icon next to the resource you want to remove, and then 
click Remove. 

3. Click OK to confirm the resource removal. The resource list is updated to 
reflect your changes.

Managing Document Templates
Templates are used to maintain structure and content consistency in Active 
WorkFlow Management(TM) documents. You add and maintain document 
templates via the Admin link on the toolbar.

4To add a document template

1. In the toolbar, click Admin.

2. Click the Document Template tab.
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3. Click Add New. The Add New Document page appears.

4. Click Browse and navigate to the location of the document template that you 
want to add, select the file, and then click Open. The File field displays the 
directory location of the file.

5. In the Name field, type a descriptive name for the document template.

6. In the Catalog drop-down list, click the catalog you want to add the template 
to. 

A catalog acts as a container for projects. For example, your organization 
may have separate catalogs for internal and external sponsored projects.

7. Click Submit. The template list is updated to reflect your additions. 

4To view a document template

1. In the toolbar, click Admin.

2. Click the Document Template tab. The templates list appears.

3. Click the Item Menu next to the document template that you want to view, 
and click View.

4. Click one of the following:

n Open – The document template is opened.

n Save – Navigate to the location where you want to save the document 
template to, and then click Save . The document template is saved to the 
location you chose. To view the saved document template, navigate to the 
location of the document template and open the file.

4To check out a document template

1. In the toolbar, click Admin. 

2. Click the Document Template tab. The templates list appears.

3. Click the Item Menu next to the document template that you want to check 
out, and click Checkout. A check mark appears next to the document 
template in the list and the File Download dialog appears.

4. Click one of the following:

n Open – The document template is opened.

n Save – Navigate the location where you want to save the document 
template to, and then click Save . The document template is saved to the 
location you chose. To view the saved document template, navigate to the 
location of the document and open the file.
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5. Once the document template is checked out you can modify the document 
template, save it, and check the document back in.

4To check in a document template that is checked out

1. In the toolbar, click Admin. 

2. Click the Document Template tab. The templates list appears.

3. Click the Item Menu next to the document template that you want to check 
in, and click Checkin. 

4. If you are reviewing the document template or just want to select this one as 
the approved version, select Approve as Master.

5. In the Comment  field, type any comments you want to be displayed with the 
document template when it is checked in.

6. Click Browse. Navigate to the location of the document, select the document 
and click Open.

7. Select one of the following:

n Minor – the version number is increased to reflect a minor revision. For 
example, Template 2.0  becomes Template 2.1 .

n Major – the version number is increased to reflect a major revision. For 
example, Template 2.0  becomes Template 3.0 .

8. Click Checkin. The document template is checked in. Active WorkFlow 
Management(TM) automatically assigns a new version number to the modified 
document template.

4To undo a checkout

1. In the toolbar, click Admin. 

2. Click the Document Template tab. The templates list appears.

3. Click the Item Menu icon next to the document template you want to undo 
the checkout for, and then click Undo Checkout. The check mark and lock 
on the document is removed. No version change is made to the document.
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Managing Project Plan Templates
Project plan templates help maintain structure and consistency in Active 
WorkFlow Management(TM) project plans. You add and maintain project plan 
templates via the Admin link on the toolbar.

Once a project plan template is created, the template is listed on the Project 
Template tab. The template is then available to be used when creating new 
project plans. Only individuals who have the necessary security permissions to 
create new projects and to access the Admin link on the toolbar can work with 
Active WorkFlow Management(TM) templates.

Creating a Project Plan Template

When you create a new project plan template, Active WorkFlow Management (TM) 
automatically assigns the current date to the template. Later, when the template is 
used in creating a new project plan, the new project plan is assigned the current 
date and not the date the template was created on.

Creating a project plan template is identical to creating a regular project plan. The 
project plan template can be assigned tasks, criteria, and documents. When a new 
project plan is created based on the template, the new project plan inherits the 
template’s tasks, criteria, and documents. 

4To create a project plan template

1. In the toolbar, click Admin. The Enroll Resources tab appears.

2. Click the Project Template tab. All existing project plan templates are listed 
on the Project Template tab.

3. Click Create New . The Create a Project Template page appears.

4. In the Project Name field, type a name for the new project plan template.

5. In the Project Description field, type a brief description of the new project 
plan template.

Note: When you create a new project based on a project plan template, the 
new project plan inherits only the master versions of documents 
associated with the template. 

Note: The Creation Date automatically assigns the template the current 
date.
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6. In the Project Catalog  drop-down list, click the catalog you want to add the 
template to. 

A catalog acts as a container for projects. For example, your organization 
may have separate catalogs for internal and external sponsored projects.

7. In the Project Type drop-down list, click the project type you want to assign 
the project plan template.

8. Click Submit. The project plan template list is updated to include your new 
template.

The new project plan template can now be edited, deleted, and assigned tasks, 
criteria, documents, and resources.

4To edit a project plan template

1. In the toolbar, click Admin. The Enroll Resources tab appears.

2. Click the Project Template tab. All existing project plan templates are listed 
on the Project Template tab.

3. Click the Item Menu  icon next to the project plan template you want to edit, 
and then click Edit. The Create a Project Template page appears.

4. In the Project Name field, type any changes to the project plan template 
name.

5. In the Project Description  field, type any changes to the project plan 
template description.

6. In the Project Type drop-down list, click the project type you want to assign 
the project plan template.

7. Click Submit. The project plan template list is updated to reflect your 
changes.

4To delete a project plan template

1. In the toolbar, click Admin. The Enroll Resources tab appears.

2. Click the Project Template tab. All existing project plan templates are listed 
on the Project Template tab.

3. Click the Item Menu icon next to the project plan template you want to 
delete, and then click Remove. A dialog prompts you to confirm you want to 
delete the project plan template.

4. Click OK to confirm that you want to delete the project plan template. The 
project template list is updated to reflect your template deletion.
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Assigning Tasks, Documents, and Criteria to Project Plan Templates

Once a project plan template is created, the template is listed on the Project 
Template tab. The template is then available to be used when creating new 
project plans. Only individuals who have the necessary security permissions to 
create new projects and to access the Admin link on the toolbar can work with 
Active WorkFlow Management(TM) templates.

You can add tasks, documents, and criteria to the project plan template. All tasks, 
documents, and criteria assigned to the project plan template are inherited by any 
project plans that are created by using the template.

For information on adding tasks, documents, and criteria to the project plan 
template, see the following chapters:

n Project Management on page41

n Gantt Tool on page51

Saving Project Plan Templates

Using the Gantt tool’s Save As feature, you can customize and save various 
versions of a project plan template by renaming the project plan template.

4To rename your project plan template

1. In the toolbar, click Admin. The Enroll Resources tab appears.

2. Click the Project Template tab. All existing project plan templates are listed 
on the Project Template tab.

3. In the list, click the name of the project plan template you want to rename and 
save.

4. Click the Gantt tab.

5. If applicable, make any changes to the project’s tasks.

6. In the Plan menu, click Save As.

7. In the Project Name  field, type a new name for the project plan template, and 
then click OK. The Update Project dialog appears and informs you the 
project plan has been saved.

8. Click OK.

Note: When you create a new project based on a project plan template, the 
new project plan inherits only the master versions of documents 
associated with the template. 
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